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1.1

1.2

1.3

Guide to this manual

Introduction

This User Manual concerns the aggregation module, D-Waq DIDO, of the Delft3D software
suite. To make this manual more accessible we will briefly describe the contents of each
chapter and appendix.

If this is your first time working with D-Waq DIDO module we suggest you to read and practice
the getting started of Chapter 3 and the tutorial of Chapter 6. These chapters explain the user
interface options and guide you through the definition of your first aggregation.

Chapter 2: Introduction to D-Waq DIDO, provides specifications of D-Waq DIDO and the
areas of applications.

Chapter 3: Getting started, explains the use of the overall menu program, which gives
access to the Delft8D modules and to the pre- and post-processing tools. Last but not least
you will get a first introduction into the D-Waq DIDO Graphical User Interface, used to define
an aggregation of grid cells which can be used in a water quality simulation.

Chapter 4: General operation, provides practical information on the general operation of the
D-Waq DIDO module.

Chapter 5: Menu options, provides a description of all menu and toolbar options.

Chapter 6: Tutorial, emphasis at giving you some first hands-on experience in using the
D-Waq DIDO module to define the input of a simple problem and in executing a water quality
simulation.

References, provides a list of publications and related material on the D-Waq DIDO module.

Appendix A: Files of D-Waq DIDO, gives a description of the files that can be used in D-
Wagq DIDO as input or output. Generally, these files are generated by D-Waq DIDO or other
modules of the Delft3D suite and you need not to be concerned about their internal details.
However, in certain cases it can be useful to know these details, for instance to generate them
by means of other utility programs.

Manual version and revisions

A manual applies to a certain release of the related numerical program. This manual applies
to D-Waq DIDO version 3.39.00.

Typographical conventions

Throughout this manual, the following conventions help you to distinguish between different
elements of text to help you learn about D-Waq DIDO.
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Example Description

Waves Title of a window or sub-window.

Boundaries Sub-windows are displayed in the Module window and
cannot be moved.
Windows can be moved independently from the Mod-
ule window, such as the Visualisation Area window.

Save Item from a menu, title of a push button or the name of

a user interface input field.

Upon selecting this item (click or in some cases double
click with the left mouse button on it) a related action
will be executed; in most cases it will result in displaying
some other (sub-)window.

In case of an input field you are supposed to enter input
data of the required format and in the required domain.

<\tutorial\wave\swan-curvi>

Directory names, filenames, and path names are ex-

<siu.mdw> pressed between angle brackets, <>. For the Linux
and UNIX environment a forward slash (/) is used in-
stead of the backward slash (\) for PCs.

“27 08 1999” Data to be typed by you into the input fields are dis-

played between double quotes.

Selections of menu items, option boxes etc. are de-
scribed as such: for instance ‘select Save and go to
the next window’.

delft3d-menu

Commands to be typed by you are given in the font
Courier New, 10 points.

~—

User actions are indicated with this arrow.

[m/s] [-]

Units are given between square brackets when used
next to the formulae. Leaving them out might result in
misinterpretation.

1.4 Changes with respect to previous versions

Version Description

3.39 Complete new version of D-Waq DIDO

Deltares
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2.1

2.2

23

Introduction to D-Waq DIDO

Introduction

Vergilius once wrote: "The Tyrian princess Dido succeeded the father and became queen of
Tyrus. Her brother Sichaeus had killed her husband, after which she fled via Cyprus to Africa.
There she asked a local king the favour to give her as much land as she could span with
the hide of a bull. When the king granted the request, she cut the hide into long, thin strips
enabling to span a much larger area. On this area Carthage was founded.”

Feel yourself in the position of DIDO with the mouse and your computer screen, to fit the real
world to your needs.

Functional description

D-Wagq DIDO is an interactive grid editor for coupling hydrodynamic models with the DELWAQ
model, D-WAQ UM (2013). It uses a rectilinear, curvilinear or Finite Element hydrodynamic
grid layout as input. It produces the administration file needed by the Delft3D Water quality
model DELWAQ to condense the fine hydrodynamic grid to a coarser water quality grid. Each
water quality grid cell consists of an integer multiple of the hydrodynamic grid cells. Using
D-Waq DIDO without aggregation will produce a DELWAQ aggregation input on the original
hydrodynamic grid spacing, although DELWAQ grid cells will be renumbered.

This means that D-Waq DIDO does NOT make grids, but modifies existing hydrodynamic grids
for use in water quality- and ecological modelling. D-Waq DIDO does so by defining a pointer
from each of the hydrodynamic grid cells to a water quality grid cell. This means that after
operation of D-Waq DIDO each hydrodynamic grid cell has a DELWAQ water quality/ecology
grid cell numbering.

Implementation specific aspects

Although D-Waq DIDO can support a variety of hydrodynamic grid structures, your version will
generally be limited to operate in concert with the hydrodynamic models available at your site.
At the point where you are able to import a hydrodynamic grid, you will generally only be con-
fronted with a selection screen showing the hydrodynamic grid files supported by your installa-
tion. Since this manual is general, certain sections will refer to options that are masked(e. g. a
regular aggregation of every m x n grid cells is meaningless for irregularly linked grids and
most finite element grids).

The output of the supported hydrodynamic models is as such insufficient for DELWAQ sim-
ulations. It is input to a coupling program between the supported hydrodynamic model and
DELWAQ. The coupling programs between the hydrodynamic program, or the hydrodynamic
program itself (e. g. Delft3D-FLOW) accept the aggregation output file of D-Waq DIDO and
produce the administration and hydrodynamic input files for D-Water Quality.
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3 Getting started

3.1  Overview of Delft3D

The Delft3D program suite is composed of a set of modules (components) each of which
covers a certain range of aspects of a research or engineering problem. Each module can be
executed independently or in combination with one or more other modules.

Delft3D is provided with a menu shell through which you can access the various modules. In
this chapter we will guide you through some of the input screens to get the look-and-feel of
the program. In the Tutorial, chapter 6, you will learn to define a simple scenario.

3.2 Starting Delft3D
To start Delft3D:

¢ On an MS Windows platform: select Delft3D in the Programs menu.
¢ On Linux machines: type delft3d-menu on the command line.

Next the title window of Delft3D is displayed, Figure 3.1.

ot ¥
ey
L 7

Verzion 41.0 email delft3d support@deltares.nl

Copyright (c) Deltares 2007-2012  Tel  +31 (0)88 335 8555
Company Buffel Enabting Delta Life

License Valid until 01-feb-2013

Figure 3.1: Title window of Delft3D
After a short while the main window of the Delft83D-MENU appears, Figure 3.2.

Several menu options are shown. For now, only concentrate on exiting Delft3D-MENU, hence:

¢ Click on the Exit push button.

The window will be closed and you are back in the Windows Desktop screen for PCs or on
the command line for Linux and UNIX workstations.

Remark: @

¢ In this and the following chapters several windows are shown to illustrate the presen-
tation of Delft3D-MENU and D-Waq DIDO. These windows are grabbed from the PC-
platform. For Linux workstation the content of the windows is the same, but the colours
may be different.
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{3 Delft3D 4.1.0 - [Dy/deltares/Delft3D 4.1._ [E=REE

Information

] Information and version numbers

Grid

i Grid and bathymetry

Flow

] Hydrodynamics (induding morphology)

Wave

] Waves (standalone)

] Partice tracking

Water Quality

] Far-field water quality (all modules)

Utilities

| Delftan utiities

[
E
[
[
[ Part
[
[
[

Exit

] Exit Delft3D menu

’ Select working directory ]

Figure 3.2: Main window Delft3D-MENU

3.3 Getting into D-Waq DIDO

To continue start the menu program again as indicated above.

¢ Click the Grid button.

Next the selection window for Grid and bathymetry is displayed for preparing a curvilinear
grid, interpolate data on that grid and aggregate the hydrodynamic cells, see Figure 3.3.

{ Grid and bathymetry - [Di/deltares/Delft3D 4.1.0] [E=NEEE
[ RGFGRID ] Boundary fitted grid generation
[ QUICKIN ] Data interpolation to computational grid
E DIDO i Grid aggregation program
[ Report RGFGRID ] View report from grid generation
[ Report QUICKIN ] View report from data interpolation to computational grid
{
I
| N
Return ] Return to Delft3D menu
’ Select working directory ]
|

——

— ———— — y

Figure 3.3: Selection window for Grid and Bathymetry

Before continuing with any of the selections of this Grid and bathymetry window, you select
the directory in which you are going to prepare scenarios and execute computations.

¢ Click the Select working directory button.

Next the Select working directory window is displayed, see Figure 3.4 (your current directory
may differ, depending on the location of your Delft3D installation).

¢ Browse to and open the <tutorial> sub-directory of your Delft83D Home-directory.
¢ Open the <wag/dido> directory.
¢ Enter the <friesian_tidal_inlet> sub-directory and close the Select working directory

6
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| Select working directory { ? = |
Look in: [ . Dt\deltares'Delft3D 4.1.0 '] Q9 O L E]
Ay My Computer . manuals

i . release_notes

Ra moaiman | source

. tutorial
w32

d3d_version.lst

Files of type: [Directnries V] I Cancel ]

Figure 3.4: Select working directory window

window by clicking button OK; see Figure 3.5.

CE=STT= )

Loak in: [ . Dt\deltares\Delft3D 4. 1.0Vtutorial wag\dido \friesian_tidal_inlet '] @ O O Li E]

& My Computer original_data

|2, mooiman

Files of type: [Dlrectcnes '] [ Cancel ]

Figure 3.5: Select working directory window to set the working directory to
< dido/friesian_tidal_inlet>

Next the Grid and bathymetry window is re-displayed, but now the changed current working
directory is displayed in the title bar, see Figure 3.6.

Remark:
¢ In case you want to start a new project for which no directory exists yet, you can select

£ in the Select working directory window to create a new folder.

¢ Click on DIDO

D-Wagq DIDO is loaded and the primary input screen is opened, Figure 3.7.

In the lower-left corner of the status bar D-Waq DIDO gives additional operational information,
see Figure 3.8, such as:
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r Bl
{3 Grid and bathymetry - [..Jwaqfdidoﬁﬁiesian_tidalﬁt_él&lﬂ
[ RGFGRID ] Boundary fitted grid generation
[ QUICKIN ] Data interpolation to computational grid
[ DIDO ] Grid aggregation program
[ Report RGFGRID ] View report from grid generation
[ Repart QUICKIN ] View report from data interpolation to computational grid
Return ] Return to Delft3D menu
E Select working directory i

Figure 3.6: A part of the current working directory is shown in the title bar due to its length

pppppppppp

a8 ine +58 Lhe L BB AR sa o)

8 x| 7S

Figure 3.7: Main window of the DIDO Graphical User Interface

¢ User selections.

¢ Operational instructions.
¢ x and y co-ordinates of the current cursor position.
¢ Co-ordinate system: Cartesian or Spherical.

Choose menu option | | X,Y: 170910414, 598230850 | | Cartesian |

Figure 3.8: Operational information displayed in the statusbar

The purpose of D-Waq DIDO is to create an aggregation file which can be used in the cou-
pling programs between a hydrodynamic simulation and D-Water Quality (i.e. Delft3D-FLOW,
SIMONA and TELEMAC).

Exiting D-Waq DIDO
To exit the D-Waqg DIDO

¢ Click Exit on the

File menu.

Deltares
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You will be back in the Grid and bathymetry window, see Figure 3.3

¢ Click Return to return to the main window of Delft3D-MENU, see Figure 3.2
¢ Click Exit.

The window is closed and the control is returned to the desk top or the command line.

We encourage new users next to run the tutorial described in Chapter 6.

Deltares 9
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4

4.1

4.2

General operation

General program operation instruction

The main menu bar is positioned at the top of the screen.

Help
Upon selecting Help — User Manual, the D-Waqg DIDO User Manual in PDF-format will be
opened. Use the bookmarks in the contents to locate the subject you are interested in.

Print screen

Press Ctrl-P or click §| on the toolbar to obtain the print window for a hardcopy of the
current screen.

File menu

The file-menu is the standard Open and Save As window. The file mask depends on the type
of data that you want to open or save. You can change the directory by navigating through the
folders.

It is possible to specify whether to Stay on the Start-up Directory or not, in the Settings
General form.

General cursor and keyboard functions
The left mouse activates or confirms desired actions. The right mouse may also confirm
actions, or may put the program back into its original mode.

Key stroke functions

D = Delete
In the Edit — Polygon and Edit — Observation Areas options, pressing D allows you to delete
individual points.

E = Erase polygon
In Edit — Polygon, keeping E pressed allows you to delete the indicated polygon.

I = Insert
In Edit — Polygon or Edit — Observation Area, pressing I when the cursor is not on a polygon
point allows you to start a new polygon.

Ctrl-P = Print screen
Pressing Ctrl-P will open the print window. The current screen will be printed to your printer
or to afile.

R = Replace
In Edit — Polygon or Edit — Observation Area, pressing R allows you to replace (move)
individual points.

Mouse wheel
Use the mouse wheel to zoom in and zoom out. Other ways are:

Deltares 11
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A
Click = on the toolbar to zoom in.
. Tty
Click A& on the toolbar to zoom out.

To define a zoom box, click # on the toolbar and drag a box.

Ctrl +=Zoomin
Keep the Ctrl-key pressed and use the + key to zoom in more.

Ctrl - =Zoom out
Keep the Ctrl-key pressed and use the - key to zoom in more.

Ctrl move cursor = move focus of screen
Keep the Ctrl-key pressed and move the cursor around. The current screen will move ac-
cordingly.

Ctrl arrow keys = move focus of screen left, right, up or down
Keep the Ctrl-key pressed and use the arrow keys to move the focus of the screen accord-
ingly.

12 Deltares



5 Menu options

5.1

The menu bar contains the following items, see Figure 5.1, each item is discussed in a sepa-
rate section

File Edit Operations View Settings Help

Figure 5.1: D-Waq DIDO menu options

File menu

Before opening an object (land boundary or polygon) be sure you choose the same co-
ordinate system as the grid file you want to edit.

Remark:
¢ When opening files, D-Wagq DIDO will not check the co-ordinate system in the files.

On the File menu, see Figure 5.2, options are available to import land boundaries, observation
areas, polygons, depth and grid files. The results at each stage of the aggregation process
can be saved.

File | Edit Operations View

™ Mew Project

(= Open Project...

I SaveProject

I SaveProject As...
Attribute Files g
Import 2
Export 2
Flow Attributes r

@ Open Colour Map...

@ Open Settings...

I SaveSettings...
Exit

Figure 5.2: Options on the File menu
The start-up directory to open and save files can be configured in the General Parameters
form on the menu Settings — General. As default the file menu starts at the last directory

selected.

For the formats of the files you are referred to Appendix A.
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New project

Upon selecting File — New Project, all objects (land boundaries, polygons, grids, depths etc.)
will be deleted; i.e. you start from scratch.

Open project
Upon selecting File — Open Project, the Open Project window appears in which you can
browse to an existing project (<x.d3d> file).

Remark:
¢ A project saved by RGFGRID or QUICKIN can be read by D-Waq DIDO

Save project

Upon selecting File — Save Project, the current project (filenames for hydrodynamic grid and
waterquality segments) will be saved under an overall project name. If the project name is not
known yet, the Save As Project window appears.

Save project as

Upon selecting File — Save Project As, the current project can be saved under a different
name.

Attribute Files

On the Attribute Files sub-menu, see Figure 5.3, options are available to open and save
objects that are indirectly related to the grids.

File | Edit Operations Wiew Settings Help

Mew Project l@ ‘:t’ 2 Je 2

Open Project...

Save Project

i i E.;D.

Save Project As...

Attribute Files ' | Openland Boundary...
Import ¥ | Open Observation Areas...
Export »
& Open Selection Polygon...
Flow Attributes 2 o 2 =
I Save Selection Polygon...
& Open Colour Map... -
[ Open Cut Out...
& Open Settings.. B SaveCutOut..

Figure 5.3: File — Attribute Files options
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Open land boundary

Upon selecting File — Attribute Files — Open Land Boundary ..., you can open a collection
of land boundaries. Land boundaries (or land-water marking) are in files with default mask
<.ldb>. It is in D-Waq DIDO only for display purposes.

Remark:
¢ If you open another land boundary, it will be visualised together with an existing land
boundary.

Open observation areas

Upon selecting File — Attribute Files — Open Observation Areas ..., you can open a collec-
tion of observation areas with a file with default mask <x.oai> (Observation Area Information
file). The polygons referenced in this file are per definition closed. If the polygon is not closed
in the file it will still be shown as closed.

Remark:
¢ If you open another oai-file, then the previous one will be deleted

Open selection area

Upon selecting File — Attribute Files — Open Selection Polygon ..., you can open a collec-
tion of area of interest polygons from a file with mask (<x.pol>). Polygons are per definition
closed. If the polygon is not closed in the file it will still be shown as closed.

Remark:
¢ If you open another polygons file, it will be visualised together with existing polygons.

Save selection polygon

When saving selction polygons, each polygon will be saved as a closed polyline. A polygon
file has as default mask <x.pol>.

Open Cut out

Upon selecting File — Attribute Files — Cut out ..., you can open a collection of cut out
polygons from a file with mask (<x.pol>). Cut out polygons are per definition closed. If the
cut out polygon is not closed in the file it will still be shown as closed.

Remark:

< If you open another cut out file, it will be visualised together with existing cut out areas.

Save Cut out

When saving cut out polygons, each cut out polygon will be saved as a closed polyline. A cut
out polygon file has as default mask <x.pol>.
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Import

On the Import sub-menu, see Figure 5.4, options are available to import objects that are
directly related to the grids.

Edit Operations View Settings Help
Mew Project l@ Ci} o @

Open Project...

Save Project

DL @

Save Project As...

b

Attribute Files

Import * = MDF-FLOW (Delft3D)...
Export 3
= Grid (RGFGRID)...
Flow Attributes r = rid { )
(& Grid Enc. (RGFGRID)...

= Open Colour Map... .
(& Gnd (TELEMAC]...
@ Open Settings... = [ .
tion...
i Save Settinas... = Aggregation
Figure 5.4: File — Import options
MDF-Flow (Delft3D)

When choosing the option File — Import — MDF-FLOW (Delft3D) . .., you can open a collec-
tion of MDF-files from a Delft3D-FLOW hydrodynamic simulation. And all relevant information
for grid aggregation is loaded from the attributes files of these MDF-files. The following at-
tributes files will be read:

& <*.grd>, the grid file

<x.enc>, the enclosure file,

<*.bnd>, the open-boundary definition file,
<x.dry>, the dry points definition file,
<*.thd>, the thin dams definition file.
<x.dep>, the depth definition file.

GO 000

It is also possible to load these files separately. For a description of the Open-boundary, dry
points, thin dams and depth definition files, see section 5.1.8.

Grid (RGFGRID)

Upon selecting File — Import — Grid (RGFGRID) . .., you can open a collection of grids. The
grid file has a default mask <x.grd>, see section A.5.

Remarks:
¢ The co-ordinate system in D-Wagq DIDO is set accordingly to the system specified in
the grid file.
¢ If the co-ordinate system is spherical then the co-ordinates are shown in stereographic
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projection.
¢ If no co-ordinate system is specified, Cartesian is presumed.

Grid Enc. (RGFGRID)

Upon selecting File — Import — Grid (RGFGRID) ..., you can open the grid enclosure file
suitable for the active grid. The grid enclosure file is strongly related to the active grid due to
the grid indices definition in the file, see section A.6.

Grid (TELEMAC)

Upon selecting File — Import — Grid (TELEMAC) ..., you can open a collection of grids
suitable for TELEMAC (triangle grid). The grid is in a file with default mask <x.geo> or
<.slf>. The open boundary files with required mask <x.cli>, are together read with the grid
if the basename of the file is the same.

Remark:
¢ The open boundary file can not be read separately after the grid is read.

Aggregation

Upon selecting File — Import — Aggregation . .., you can open one aggregation file suitable
for the active grid. The aggregation is in a file with default mask <x.dwq>, see Appendix A.2.

Export

On the Attribute Files sub-menu, see Figure 5.5, options are available to export objects that
are directly related to the grids.

Edit Operations View Settings Help
Mew Project l@ Ci} 7 %

Open Project...

Save Project

Do O

Save Project As...

-

Attribute Files
Import k

Export * |l Observation Areas...
Flow Attributes * | Aggregation...

Figure 5.5: File — Export options
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Observation areas

Upon selecting File — Export — Observation Areas . .., you can save the observation areas.

The data is stored in three separate files,

1 Observation Area Information file, containing general information about the observation
areas. The file has default mask <x.aoi>, see appendix A.9. Such as the names of the
areas and the reference to the polygon file with the actual polygons.

2 Polygons, these polygons indicate the observation area in world co-ordinates and is there-
for independent of the numerical model. The file has default mask <x.pol>, see ap-
pendix A.4.

3 DMO, these file contains the segment numbers for each observations area and can be
used in the input file of D-Water Quality. The file has default mask <x.dmo>, see ap-
pendix A.10.

When asked to save the polygon file, click Yes.

Aggregation

Upon selecting File — Export — Aggregation ..., you can save the aggregation of the active
grid. The aggregation is stored in a file with default mask <x.dwqg>.

Flow attributes

Open-boundaries, DD-Boundaries, Dry points and Thin Dams definitions for the hydrody-
namic module Delft3D-FLOW or SIMONA need to be incorporated before generating the
aggregation, see Figure 5.6. The dry points are needed when generating the aggregation
because the dry points are not involved in the hydrodynamic computation and do not have
a cell/'segment number. The Open and DD-boundaries are needed because the cells at the
boundary has their own numbering. See the SIMONA user manual (Rijkswaterstaat/RIKZ,
2007) how to define dry points for the hydrodynamic module SIMONA.

Open Open-Boundaries (Delft3D )

Upon selecting File — Flow Attributes — Open Open-Boundaries (Delft3D) . .., you can open
the open boundary file. Visualising the open boundaries can help you with the aggregation of
hydrodynamic cells. The open boundary is in a file with mask <x.bnd>, see Appendix A.8.

Open DD-Boundaries (Delft3D)

Upon selecting File — Flow Attributes — Open DD-Boundaries (Delft3D) ..., you can open
the domain decomposition boundary file. Visualising the DD-boundaries can help you with
the aggregation of hydrodynamic cells. The domain decomposition boundary is in a file with
mask <x.ddb>, see Appendix A.11.

18 Deltares



Menu options

Edit Operations View Settings Help

[ Mew Project l@ I, B I
= Open Project...
I saveProject
I SaveProject As...

Attribute Files »

Irnport 2

Export k

Flow Attributes ¥ |(= Open Open-Boundaries (Delft30-FLOW)...
= Open Colour Map... = Open DD-Boundaries (Delft30)...

= Open Dry Points (Delft30]...

(& Open Seftings.. Z Open Thin Dams (Delf3D)...
I SaveSettings.. = Open Depth (Delft3D)...

58 Z Open Dry Points (SIMONA)...

Figure 5.6: File — Flow Attributes options

Open Dry Points (Delft3D)

Upon selecting File — Flow Attributes — Open Dry Points (Delft3D) ..., you can open one
dry points file suitable for the active grid. The dry points are not counted in the segment
numbering, so loading dry points DIDO generates the ’Active Points Only’ segment numbers.

When opening a file with dry points and dry points are already defined, then the latter will be
removed, see Appendix A.12 for the file format.

Open Thin Dams (Delft3D)

Upon selecting File — Flow Attributes — Open Thin Dams (Delft3D) ..., you can open one
thin dams file suitable for the active grid. When a regular aggregation is applied, the aggre-
gated segments which would contain a thin dam are not aggregated. This option maintains
the geographical structure in the aggregated grid. Aggregations around thin dams have to
performed with the option of area of influence (Edit — Polygon) and regular aggregation or
manually (option Edit — Irregular)

When opening a file with thin dams and thin dams are already defined, then the latter will be
removed, see Appendix A.13 for the file format.
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Open Depth (Delft3D)

Upon selecting File — Flow Attributes — Depth (Delft3D-FLOW) .. ., you can open one depth
file suitable for the active grid. The bathymetry can be used to influence the aggregation
policy, see section 5.5.1 item Aggregation below Z-level.

The bathymetry data is in the Delft3D-FLOW depth-file format with default mask <x.dep>,
see Appendix A.7.

Open Dry Points (SIMONA)

Upon selecting File — Flow Attributes — Open Dry Points (SIMONA) ..., you can open one
dry points file suitable for the active grid. The dry points are not counted in the segment
numbering, so loading dry points DIDO generates the ’'Active points Only’ segment numbers.

When opening a file with dry points and dry points are already defined, then the latter will be
removed. The dry points data is in SIMONA format with default mask <dampoints*>, see the
SIMONA User Manual Rijkswaterstaat/RIKZ (2007) for the file format..

Open Colour map

You can choose from a number of pre-defined colour schemes (in file with masks <x.clr> or
<.clrmap>). These colour schemes have the same format as used for Delft3D-QUICKPLOT,
see Appendix A.14 for the file format.

Restriction:
¢ Only the colour space RGB is supported

Remark:
¢ If the file <dido.clrmap> exists on the start-up directory then this file will be read, if the
file does not exist on the start-up directory it will try to read the file on the installation
directory <$D3D_HOME/$ARCH/plugins/default>.

Open Settings
If you have saved your D-Waq DIDO settings in a previous session, you can open these
settings again, see Appendix A.15 for the file format.

Remark:
¢ If the file <dido.ini> exists on the start-up directory then this file will be read, if the
file does not exist on the start-up directory it will try to read the file on the installation
directory <$D3D_HOME/$ARCH/plugins/default>.

Save Settings

If you have made changes in one of the forms on the Settings menu, you can save these
settings to be used later on again.
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5.2.1

5.2.2
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Exit
Exit from the D-Waq DIDO program

Edit menu

On the Edit menu, see Figure 5.7, several edit modes can be selected

Operations  View 5

Regular
Irregular

Break up

Selection Polygon
Cut Out Area k

Observation Area  »

Figure 5.7: Options on the Edit menu

Regular

Upon selecting Edit — Regular, you can make a regular aggregation of the hydrodynamic grid
cells.

Click with the left mouse button in a grid cell of the hydrodynamic grid, then move the mouse
to an other grid cell. The grid cells which will be aggregated are indicated with a thick line.
Pressing the right mouse button will give a regular aggregation for the whole model.

Remark:
¢ The operation can be limited by a polygon, this polygon defines an area of influence.
So the aggregation will only be performed for those cells whose cell centre are inside
the polygon. Cell centres are indicated by a dot.

Irregular

Upon selecting Edit — Irregular, you can make a irregular aggregation of the hydrodynamic
volumes.

Click with the left mouse button in a grid cell of the hydrodynamic grid, then all the cells with
the same aggregation number are surrounded with a thicker line. To add a grid cell, to the
grid cells already indicated, click into another grid cell. Do this as much as needed. Finish the
operation by pressing the right mouse button.
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Break up
Upon selecting Edit — Irregular, you can break up an aggregation.

Click into an area which is already aggregated to break up this aggregation, i.e. the default
aggregation is reset for this aggregated cell.

Selection polygon

The polygon is used to limit the area of influence of operations and/or edit actions, see Fig-
ure 5.8.

Operations  View Settings Help

Regular l{t’ B
Irregular
Ereak up
Selection Polygon Edit
Cut Out Area r
. 4?..' New
Observation Area  #
26 Delete
Select

f"- Inzert Point
:?’ MMowve Point
f“ Delete Point

Figure 5.8: Options on the Edit — Selection Polygon menu

Edit

Upon selecting Edit — Selection Polygon — Edit, you can start editting a polygon that defines
a selection area. When there is no polygon the edit mode is set to New, otherwise you have
to select first a polygon (from the menu Edit — Selection Polygon — Select or press the key
s). After you have selected the polygon you can use key-strokes, icons in the toolbar or menu
items to switch the edit mode.

New

Upon selecting Edit — Selection Polygon — New, you can start to define a new polygon, click
on i’"', or use the key-stroke n to start a new polygon.

Delete

Upon selecting Edit — Selection Polygon — Delete, click on 2 or use the key-stroke e, to
delete (erase) the selected polygon.
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Select

Upon selecting Edit — Selection Polygon — Select, or use the key-stroke s, you can select a
polygon by clicking on one of its edges or vertices. AFter that the polygon will be highlighted

Insert point

Upon selecting Edit — Selection Polygon — Insert Point, click on ! *, or use the key-stroke
i, you can insert a point into the selected polygon. The point will be inserted at the nearest
linear piece of the polygon.

Move point

Upon selecting Edit — Selection Polygon — Move Point, click on 3", or use the key-stroke r,
you can move (replace) a point on the selected polygon.

Delete point

Upon selecting Edit — Selection Polygon — Delete Point, click on = oruse the key-stroke
d, you can delete a point on the selected polygon by indicating it.

Cut out area

The polygon is used to limit the hydrodynamic area for the Water Quality simulation, see
Figure 5.9.

Operations  View Settings  Help
Regular l‘i’ o @
Irregular

Break up

Selection Polygon
Cut Qut Area 2 Edit

Ohservation Area  »
Mew

Delete

X7

Select

J* Insert Point
:7' Move Point
f‘ Drelete Point

Figure 5.9: Options on the Edit — Cut Out Area menu

Edit

Upon selecting Edit — Cut Out Area — Edit, you can start editting a polygon that defines an
Cut Out Area. When there is no polygon the edit mode is set to New, otherwise you have to
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select first a polygon (from the menu Edit — Cut Out Area — Select or press the key s). After
you have selected the polygon you can use key-strokes, icons in the toolbar or menu items to
switch the edit mode.

New

Upon selecting Edit — Cut Out Area — New, you can start to define a new polygon, click on
i"", or use the key-stroke n to start a new polygon.

Delete

Upon selecting Edit — Cut Out Area — Delete, click on 2 or use the key-stroke e to delete
(erase) the polygon.

Select

Upon selecting Edit — Cut Out Area — Select, or use the key-stroke s, you can select a
polygon by clicking on one of its edges or vertices. After that the polygon will be highlighted

Insert point

Upon selecting Edit — Cut Out Area — Insert Point, click on i *, or use the key-stroke i, you
can insert a point into the polygon. The point will be inserted at the closest linear piece of the
polygon.

Move point

Upon selecting Edit — Cut Out Area — Move Point, click on }’, or use the key-stroke r, you
can move (replace) a point on the polygon.

Delete point

Upon selecting Edit — Cut Out Area — Delete Point, click on ?‘, or use the key-stroke d, you
can delete a point on the polygon by indicating it.
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Operations  View Settings  Help
Regular l{t’ T B

Irregular

Break up

Selection Polygon  »

Cut Out Area L4
Ohbservation Area # Edit
‘? v Mew
D6 Delete
¥ Select
Edit Mame
f"- Insert Point
:7' Move Point

f‘ Delete Point

Figure 5.10: Options on the Edit — Observation Area menu

Observation area

Observation areas are collections of individual computational segments. The concentration,
computed by D-Water Quality, in each segment is averaged and the mass balances, if any,
are computed for the segments as a whole.

First you have to define the locations of observation areas by editing polygons, see Fig-
ure 5.10.

For each area a polygon is required. When editing the polygon the default observation area
name is immediately given ('ObsArea ???’) and the segments which belong to this observa-
tion area are indicated by a thick line. When saving the observation areas the polygons and
segment numbers are saved in a separate file, see Section 5.1.7.

Edit

Upon selecting Edit — Observation Area — Edit, you can start editting a polygon that defines
an Observation Area. When there is no polygon the edit mode is set to New, otherwise you
have to select first a polygon (from the menu Edit — Observation Area — Select or press the
key s). After you have selected the polygon you can use key-strokes, icons in the toolbar or
menu items to switch the edit mode.

New

Upon selecting Edit — Observation Area — New, click on % or use the key-stroke n, you
can sart to define a new observation area. Right mouse click to finish defining this polygon,
next click with left mouse button will start a new observation area.
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Delete

Upon selecting Edit — Observation Area — Delete, click on 7 or use the key-stroke e, you
can delete (erase) a observation area by indicating it with the left mouse button.

Select

Upon selecting Edit — Observation Area — Select, or use the key-stroke s, you can select a
polygon by clicking on one of its edges or vertices. After that the polygon will be highlighted

Edit name

Upon selecting Edit — Observation Area — Edit Name, you can change the observation area
name by indicating the area with the left mouse button. After this a form opens and you can
change the observation area name, see Figure 5.11.

ﬂl Chsersation Area I. ? i"j—]

Mame = Observation Area 00 1|

Ok ] | Cancel |

[ -

Figure 5.11: Window Observation Area to change the observation area name

Insert point

Upon selecting Edit — Observation Area — Insert Point, click on Iy " or use the key-stroke i,
you can insert a point into the polygon. The point will be inserted at the closest linear piece of
the polygon.

Move point

Upon selecting Edit — Observation Area — Move Point, click on :V, or use the key-stroke r,
you can move (replace) a point on the polygon.

Delete point

Upon selecting Edit — Observation Area — Delete Point, click on - , or use the key-stroke
d, you can delete a point on the polygon by indicating it.

Operations menu

On the Operations menu, see Figure 5.12, you may choose to change the centre of the
stereographic projection, remove the land boundary or generate a default aggregation.
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5.3.2

5.3.3

5.3.4

5.3.5

5.4

Menu options

‘u‘iew Settings  Help

Select Domain...

Delete Domain...
@ Change Centre of Projection
Delete Land Boundary

Default Aggregation

Figure 5.12: Options on the Edit menu

Select domain

If your project consists of multiple grids (so-called domain decomposition application) you can
switch between the grids by clicking Edit — Select Domain, or click &l on the toolbar. Next,

click on the grid you want to become the active grid.

Delete domain

To delete a domain or grid, select Edit — Delete Domain. Next, click on an active or inactive
grid. When deleting a domain, also objects defined on that grid will be deleted.

Change centre of projection

For spherical co-ordinates D-Waq DIDO can use two different projections, no projection and
stereographic projection. For stereographic projection a special function is implemented to
centring the computer screen to the centre of projection and the sphere. This function can be
invoked by clicking the menu item Operations — Change Centre of Projection see Figure 5.12.
When using this command the centre of the projection is set to the centre of the screen. This
action requires recalculation of the projection and a new screen refresh. The centre of the
projection does not change when using zoom in, zoom out or pan, so there is no performance
drawback and a smooth screen-refresh is obtained.

Delete land boundary

All the points of the land boundary are removed.

Default aggregation

The default aggregation is no aggregation, so all water quality cells are equal to the hydrody-
namic cells. If a polygon is defined, the default aggregation is restricted to the inner area of
the polygon, i.e. the default aggregation is performed on those cells which have their centres
within the polygon.

View menu

On the View menu, you may choose to display several data sets; see Figure 5.13
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Settings  Help

Spherical Co-ordinates 2
Legend

Grid Information »
Find Grid Cell...
Check Partition

Land Boundary

Observation Areas
¥ | Water Quality Grid

Hydrodynamic Grid
v Boundary

Depth

Dry Points
Thin Dams

Figure 5.13: Options on the Edit menu

5.4.1 Spherical co-ordinates

Here you can select how to project the spherical co-ordinates onto the screen, see Fig-

ure 5.14.
Settings  Help
Spherical Co-ordinates L Plane Co-ordinates
Legend v | Stereo Projected Co-ordinates
Figure 5.14: Options on the View — Spherical Co-ordinates menu
Remarks:

¢ Only applicable for a spherical co-ordinate system.
¢ Default: A spherical grid is shown in stereographic projected co-ordinates

Plane co-ordinates

Upon selecting View — Spherical Co-ordinates — Plane Co-ordinates, you can choose to the
display the co-ordinates as they are.

Stereo projected co-ordinates

Upon selecting View — Spherical Co-ordinates — Stereo Projected Co-ordinates, the co-
ordinates are displayed using a stereographic projection onto the screen.
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Legend

Upon selecting View — Legend, you can show or hide the colour band on the left side of the
screen.

Grid information

Upon selecting View — Grid Information, you can point and click onto the grid to get some
characteristics cell numbers of the indicated cell, see Figure 5.16. The cell is also indicated
by a polygon.

Settings  Help
Spherical Co-ordinates k BM I.._ :},- }g‘

Legend
Grid Information L4 Mode Mumbers
Find Grid Cell... WAQ Cell Mumbers
Check Partition FLOW Cell Murmbers
e ot Grid Cell Indices
Select Cell...

Chbservation Areas

Figure 5.15: Grid information

Node numbers

Upon selecting View — Grid Information — Node Numbers, you can show or hide the node
numbers of the hydrodynamic grid. If it is a regular (structured) grid, two indices will displayed
(m,n), if it is an irregular (unstructured) grid then just the number of the grid node will be
displayed.

WAQ cell numbers

Upon selecting View — Grid Information — WAQ Cell Numbers, you can show or hide the
cell numbers of the water quality grid. For a regular (structured) as well as a irregular (un-
structured) grid the cell number will be displayed.

FLOW cell numbers

Upon selecting View — Grid Information — FLOW Cell Numbers, you can show or hide
the cell numbers of the hydrodynamic grid. For a regular (structured) as well as a irregular
(unstructured) grid the cell number will be displayed.

Grid cell indices

Upon selecting View — Grid Information — Grid Cell Indices, you can show or hide the index
numbers of the regular (structured) hydrodynamic grid, two indices will displayed (m, n).
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Select cell

Upon selecting View — Grid Information — Select Cell.. ., you can retrieve some cell admin-
istration. After selecting a cell these information will be showed in the Cell Administration
window, see Figure 5.16.

5| Cell Administration Lé]

—
o
(=2}

i _Ch , MN
vy Flow

Waq

17

Figure 5.16: Grid information

Find grid cell

Upon selecting View — Find Grid Cell. . ., you can find the hydrodynamic or water quality grid
cell. To find the hydrodynamic grid cell type in its number and set the water quality grid cell
to zero. To find the water quality grid cell type a zero for the hydrodynamic grid cell and the
a cell number for the water quality The last search will indicate more than one cell if the grid
was aggregated.

! Give cell number I. 2 ihJ

FLOW cell number 0

waQ cellnumber 17

[ OK ] I Cancel I

Figure 5.17: Give cell number menu

Check partition

Upon selecting View — Check Partition, you can check if the observation areas do partition
the whole computational area. This functionality can be useful to generate some data fields
which need to cover the whole area.

Cells can not be inside more than one observation area, see Figure 5.18. The cells are
coloured accordingly

Green: The cell centre is in just one observation area.
Red: The cell centre is in more than one observation area.
Blue: The cell centre is outside any observation area.
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5.4.8

5.4.9

5.4.10

5.4.11

5.4.12

Menu options
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Figure 5.18: Check partition

Land boundary

Upon selecting View — Land Boundary, you can show or hide the land boundary. The land
boundary is drawn as a polyline.

Observation areas

Upon selecting View — Observation Areas, you can show or hide the observation areas.

Water Quality grid

Upon selecting View — Water Quality Grid, you can show or hide the water quality grid. The
water quality grid is drawn above the hydrodynamic grid.

Hydrodynamic grid

Upon selecting View — Hydrodynamic Grid, you can show or hide the hydrodynamic. The
hydrodynamic grid is drawn below the water quality grid.

Boundary

Upon selecting View — Boundary, you can show or hide the open boundaries.

Depth

Upon selecting View — Depth, you can show or hide the depth values. The depth is located
at the cell corners of the hydrodynamic grid.

Dry points

Upon selecting View — Dry Points, you can show or hide the dry points. The dry point is
located at a cell of the hydrodynamic grid.
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5.4.13 Thin dams

Upon selecting View — Thin Dams, you can show or hide the thin dams. The thin dam is

located at the cell faces of the hydrodynamic grid.

5.5 Settings menu

The following options can be accessed through the Settings menu, see Figure 5.19

General...

Change Colour Map...

Legend...

Colours...

Sizes...

Crder Caches...

Figure 5.19: Options on Settings menu

5.5.1 General

When clicking on the Settings — General menu, a form opens in which you can select some

general parameters; see Figure 5.20

¢ Stay on Startup directory

default: 0 (Off)

When navigating through the directories in the file selecting window, you can specify
whether to always go back to the start up directory (1), or keep the latest directory (0).

o Cells to Aggregate

default: 3

Maximum number of volumes which can be aggregated to one water quality volume for an
unstructured grid for hydrodynamics. TELEMAC allows the values 1, 2 and 3.

o Aggregation below Z-level

default: co

The aggregation will be performed where the depth is deeper then the given reference
level, for the shallower parts of your model no aggregation will be performed.

p
ﬂ.l General Parameters

T |-

Cells to Aggregate

Stay on Startup Directory 0

3

Aggregation below Zdevel 12430

Ok

||

Cancel

.,

Figure 5.20: Options on Settings — General menu
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5.5.2 Change colour map

When clicking on the Settings — Change Colour Map menu, a form opens in which you
can select the relation between a parameter (i.e. Depth) and the loaded colour maps, see

Figure 5.21
{54! Join Parameter to Colour Map l 2 &J\
Parameter ’Depﬂ'u - ]
Colour Map [jet - ]
[ Apply ] [ QK l ’ Cancel ]
Figure 5.21: Options on Settings — Colours menu
5.5.3 Legend

When clicking on the Settings — Legend menu, a form opens in which you can define how
the iso-colour figures should be displayed; see Figure 5.22

ﬂf Legend

Pl X

Autoscale Legend 1

Mumber of digits 3
Minimum Value 1=+30
Maximum Value -1e4+30
Classes 20

¥ Co-ordinate Legend 15

¥ Co-ordinate Legend 20

oK | |

Cancel

Figure 5.22: Options on Settings — Legend menu

¢ Autoscale Legend

default: On

Specify whether the program should determine the isocolour values automatically, or to
do it yourself. If you leave it to the program, it will determine the minimum and maximum
depth value within the viewing area and display the number of iso-colours specified above.
Zooming in will always result in display of the same number of iso-colours. If you want to
specify the isocolour values yourself, you have to specify one of the three parameters
below. When zooming in, the iso-colour values will remain fixed.
Minimum Value

Specifying this value turns autoscale off.

Maximum Value

Specifying this value turns autoscale off.

Classes

The number of classes can be specified

default: 20
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¢ X Co-ordinate Legend default: 16
X Co-ordinate of lower left corner of legend in pixels
¢ Y Co-ordinate Legend default: 20

Y Co-ordinate of lower left corner of legend in pixels

5.5.4 Colours

When clicking on the Settings — Colours menu, a form opens in which you can define the
colours for background, land boundary, polygons, etc.; see Figure 5.23

ﬁ’ Caolours
Badkground White
Legend Background White
Text W Custom
Land Boundary B Custom
Polygon B Custom
Active Grid M Dark aray

Indicate Volumes
Active Volumes
Active Computational Boundary B Custom

Active Open Boundary

Active DD Boundary B Custom
Inactive Grid
Inactive Volumes W Dark gray

Inactive Computational Boundary | [l Custom
Inactive Open Boundary B Custom
Inactive DD Boundary B Custom
Volume Centre Custom
Observation Areas W Custom
Dry Points W Glack

Thin Dams Bl Custom

O
[ (]
['w] [T}
=3 = =9
g 2 EE
[s1) =T}
- =]

[ OK ] [ Cancel

Figure 5.23: Options on Settings — Colours menu

5.5.5 Sizes

When clicking on the Settings — Sizes menu, a form opens in which you can define the
linewidth and dotsize in pixels. See Figure 5.24
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ﬂl Sizes

Land Boundary

Polygon

Active Grid

Indicate Volume

Active Volume

Active Computational Boundary
Active Open Boundary

Active DD Boundary

Inactive Grid

Inactive Volume

Inactive Computational Boundary
Inactive Open Boundary
Inactive DD Boundary

Volume Centre

Thin Dam

Observation Areas

[ o |

Cancel

Figure 5.24: Options on Settings — Sizes menu

5.5.6 Order caches

The parameters set in the Order caches window, see Figure 5.25, influence the drawing order
of the several items. The drawing order of the caches is: 5,4, 3, 2,1, 0. Cache 5 is drawn first
and cache 0 is drawn last. So the items which will drawn in cache 0 are drawn on top. If
there is no need to draw a cache it will not be done, this improves the drawing performance
by avoiding unnecessary drawings. Therefore, if an item is changed in cache 3 only caches

3,2,1and 0 are drawn.

<

Inactive Depth
Active Depth
Centres

Inactive Grid
Active Grid
Inactive Volumes
Active Volumes
Boundaries
Land Boundary
Obs. Areas
Drypoints, Thin Dams, Observation Points
Samples

C O 000000000

Deltares

default:
default:
default:
default:
default:
default:
default:
default:
default:
default:
default:
default:
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ﬂll Order Caches l_‘_J@ i
Inactive Depth 5
Active Depth 5
Centres 5
Inactive Grid 4
Active Grid 4
Inactive Volumes 3
Active Volumes 2
Boundaries 1
Land Boundary 1
Obs. Areas 2
Palygons 0
Dry Points, Thin Dams, Cbservation Points, Discharges 1
Rest 1
[ OK ] ’ Cancel

Figure 5.25: Options on Order Caches window
User Manual...

About...

Figure 5.26: Options on Help menu

Help menu

On the Help menu, you may choose to read the user manual or the version number of D-Waq
DIDO; see Figure 5.26

User manual

When clicking on the Help — User Manual the user manual of D-Waq DIDO will be displayed
(<D-Waq DIDO _User_manual.pdf>).

About

When clicking on the Help — About a window will display the current version number of D-
Wagq DIDO.
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5.7 Toolbar

A list of all toolbar icons is given below:

é‘ Click this icon to obtain the print window for a hardcopy of the current screen.

& @ M Ak 2

£l

=]
o
]

Click this icon to zoom out to full extent.
Click this icon to zoom in.

Click this icon to zoom out.
Click this icon and drag a box to zoom in to that area.

Click this icon to centre the stereographic projection at the centre of the screen

Click this icon, move the mouse pointer to the reference point for which you want the
distance from, then press a or A to fix the anchor point

Click this icon to refresh the drawing.
If your project consists of multiple grids (so-called domain decomposition application) you

B , .
can switch between the grids by clicking on the toolbar. Next, click on the grid you
want to become the active grid.

Show or hide the legend.
Click this icon to start a new polygon (Area of influence or Cut out area as indicated in the
statusbar).

Click this icon to delete a polygon (Area of influence or Cut out area as indicated in the
statusbar).

Click this icon to insert a point into the polygon (Area of influence or Cut out area as
indicated in the statusbar). The point will be inserted at the closest linear piece of the
polygon.

Click this icon to move a point on the polygon (Area of influence or Cut out area as indi-
cated in the statusbar).

Click this icon to delete a point on the polygon (Area of influence or Cut out area as
indicated in the statusbar) by indicating it.
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6.1

6.2

Tutorial

Introduction

In this tutorial some functionality of D-Waqg DIDO will be demonstrated. On the basis of the
"Friesian Tidal Inlet" example a D-Waq DIDO session is explained. In advance, both the
starting situation and the final situation are shown below in Figure 6.1.

This tutorial describes in detail how to proceed from the starting situation towards the final
situation.

T ‘%‘\
%%,
s

TR ;'.'.
e
Do

RS
EEE“’:"

Choose menu option | | X.¥: 187451811, 626127.475] | Cartesian Breakup aggregation | | X.Y: 186244566, 623822735 | |

(a) Not aggregated, start situation (b) Aggregated, final situation - E

Figure 6.1: Starting and final situation of the clarified D-Waq DIDO session

Before you can start with the tutorial you have to start Delft3D and set the working directory
to the tutorial model located on <%D3D_HOME%/tutorial/wag/dido/friesian_tidal_inlet>.

Loading the model

Open the grid and land boundary file. The grid file is the grid which will be use by the hy-
drodynamic program, Delft8D-FLOW (2013). The land boundary file is just for orientation
purposes.

¢ On the File menu, point to Import and click on Grid (RGFGRID)
¢ Select and Open the <friesian_tidal_inlet.grd>

¢ On the File menu, point to Attributes Files and click on Open Land Boundary
¢ Select and Open the <netherlands.ldb>

Now the grid and land boundary are visualised in the D-Waq DIDO window, see Figure 6.2.
Although the land boundary has a greater extent the extent of the window is unchanged. The
first opened file determines the extent of the main window.
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Figure 6.2: Hydrodynamic grid

6.3 Zoom out and zoom in

Zooming out the model in discrete steps

. L
¢ Click on 2%,

To zoom out to the full extent of all loaded files

¢ Click on @.

Now you have a picture where you can see the whole Dutch coast, and as you can see
Friesian Tidal Inlet model is in the north of The Netherlands.
To zoom in on the grid there are several possibilities

¢ Use the mouse scroll wheel. The cursor is the fix point when scrolling the mouse wheel.

o Click on # and drag a rectangle. Do it several times after each other and terminate the
zoom in action by pressing the right mouse button.

. FA
¢ Click on 3.

To pane the grid: keep the CTRL-key down and move around with the cursor.
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6.4 Two by two aggregation

The grid and land boundary are loaded and the next step will the hydrodynamic grid to two by
two cells aggregation which will be used by the water quality grids.

Choose the menu-option Edit — Regular, you can click the two corner cells which form the
outline of the new aggregated cell.

¢ Click on the first cell (see Figure 6.3)
¢ Move the mouse to the opposite corner
¢ Click on the right mouse button to obtain the aggregation for the whole area, Figure 6.4

e

Regular aggregaton| | XY: 1800646978, 616477549 | |

Figure 6.4: Result of a two by two aggregation

6.5 Default aggregation in inlet

The whole model has now a aggregation of two by two grid cells. But in the entrance of the
tidal inlet we do not need an aggregation of the hydrodynamic grid. There are several options
to reach this situation.

1 use the break up option
2 define an area of influence and define a new aggregation with that area
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Break up the aggregated cells

Choose the menu-option Edit — Break Up, you can click into an aggregated cell to obtain the
default aggregation for that cell. Continue with clicking into the several aggregated grid cells
to get the result aggregation as shown in Figure 6.1 In this way you have fully control to break
up the aggregation for each cell.

Define area of influence

An other way to obtain the final aggregation as shown in Figure 6.1 is to define an area of
influence. An area of influence is that area to which the operation is restricted and is defined
by a polygon. So we start with defining a polygon.

Choose the menu-option Edit — Polygon — New or click on the toolbar icon " and next
clicking the left mouse button to define the polygon to get Figure 6.5

st | Add aVertex| X.Y: 180303557, 617432982 ||

Figure 6.5: Area of influence defined by the polygon

Choose now the menu-option Operation — Default Aggregation and within the polygon all
aggregated cells have the default aggregation, i.e. the water quality cells are equal to the
hydrodynamic cells.

Saving the result
Before you end your D-Waq DIDO session you have to save the results from the aggregation.
The aggregation can be saved to file.

Choose the menu option File — Export — Aggregation. and the Save Aggregation window
will be opened (Figure 6.6)

Or choose the menu option File — Save Project As and the Save Project window will be
opened (Figure 6.7). After saving the project file (<*.d3d>) the window Save Aggregation
to save the aggregation file <x.dwq> will appear (Figure 6.8).

The advantage to save the aggregation in a <x.d3d> file is that the reference to all the grids
and their aggregation are saved, especially for multi domain models this is an advantage.
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1| Save Aggregation

8 [

Look in: [ . Di\Peltares\Delft3D 4. 1.0\tutorial\wag\dido friesian_tidal_inlet '] O (=] 0 L @
* My Computer Name ° Size Type Date Modi
|2, mooiman
] 1 ] b
File name: save
Files of type: | *.dwg V] I Cancel

Figure 6.6: Save Aggregation window

.| Save Project M
Look in: [ . Di\Peltares\Delft3D 4. 1.0\tutorial\wag\dido friesian_tidal_inlet '] (> ] 0 L @
* My Computer Name = Size Type Date Modi
|2, mooiman
< I I "
File name: friesian_tidal_inlet
Files of type: [‘.d:’d V] I Cancel ]

Figure 6.7: Save Project window, saving Friesian Tidal Inlet project

| Save Aggregation - [f34]

7 ]

Look in: [ . Di\Deltares\Delft3D 4. 1.0\tutorial\wag\dido friesian_tidal_inlet

oo o lEE

A My Computer

|2, mooiman

Name

=

Size Type Date Modi

<

1

] r

File name: friesian_tidal_inlet-F34.dwg

Save

Files of type: [‘.dwq

- ] I Cancel ]

Figure 6.8: Save Aggregation window, saving the Friesian Tidal Inlet aggregation
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TELEMAC grid files

TELEMAC users can also use D-Waq DIDO to aggregate the water quality grid cells. TELEMAC
is an hydrodynamic program which uses unstructured collocated triangular grids (see Fig-
ure 6.9).

Before you can start with this tutorial you have to start Delft3D and set the working directory to
the tutorial model located on <%D3D_HOME%/tutorial/waqg/dido/bridge_in_river> and load
the file <bridge_2_pillars.geo>, File —Import — Grid (Telemac)

e =

CBE x|y

(Choosemenuoption| | X¥: 39953, 576m] | |

Figure 6.9: TELEMAC hydrodynamic triangular grid

Due to the collocation of the variables in TELEMAC and the need of finite volumes in the
water quality program D-Water Quality, see D-WAQ UM (2013), the hydrodynamic grid and
the water quality grid are different, as seen by comparison of the Figures 6.9 and 6.10

A

s

Figure 6.10: Finite Volume grid, based on a triangular collocated hydrodynamic grid

The aggregation of water quality cells is not as straightforward as for structured grids with
staggered variables used in Delft3D-FLOW. For Delft3D-FLOW and D-Water Quality the hy-
drodynamic grid and the default water quality grid is the same. For unstructured grids we
allow two different options of aggregation

1 Default aggregation
2 Aggregate at most three cells together
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The default aggregation means that all finite volumes around the hydrodynamic grid nodes(indicated
by a dot in the figures) are disjunct.

For a three cell aggregation choose the menu-option Edit — Regular, you can click the inter-
section point of three different volumes to aggregate this cells. These three cells will be the
starting point of the algorithm to aggregate as much as possible three hydrodynamic cells to
one water quality cell. Due to the irregularity of the grid you will see that some water quality
cells are not aggregated and others are just aggregated to their neighbour.

¢ Click on intersection point
¢ Click on the right mouse button to obtain the aggregation for the whole area, Figure 6.11

& e i INE ~—~y = T

guiroggregaton| | K¥: 13351, 93271 ||

Figure 6.11: Aggregated Finite Volume grid

All other options of D-Waq DIDO can also be used in combination with a TELEMAC grid.
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A Files of D-Waq DIDO

A1

In the following sections we describe the attribute files used in D-Waq DIDO.

For each file which can handled by D-Waq DIDO we give the following information:

¢ File contents.

Filetype (free formatted, fix formatted or unformatted).
¢ Filename and extension.

Generated by (i.e. how to generate the file).

¢ Restrictions on the file contents.

Example(s).

<

o

<

Remarks:
¢ The access mode of all attribute files is sequential.
¢ In the examples the file content is printed in font Courier and comment (not included in
the file) between curly brackets font, unless explicitly stated differently.

Delft3D project file

File contents Domain input for a model.

Filetype ASCII

File format Free formatted.

Filename <name.d3d>

Generated RGFGRID, QUICKIN, D-Wagq DIDO, or manually offline
Record description:

A header block containing general information and then for each domain a detailed descrip-
tion.
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Keyword

Description

FileInformation

FileCreatedBy

Version string of the program who generated this file the first time

FileCreationDate

Creation date and time

FileVersion Version number of <x.d3d> file

Geometry

LandBoundaryName Name of the file with the land boundaries

LandBoundaryFormat | Format of the land boundary file, possible values are: TEKAL,
NETCDF or SHAPEFILE. The NetCDF file is according the 'World
Vector Shoreline’ format

DDBound

FileDDBound Name of the file with the domain decomposition boundaries

For each grid

Keyword Description
Grid
Type Format of the grid file, possible values are: RGF, RGF_NETCDF,
DFLOW_FM, TELEMAC
FileName Name of grid file with the geographical co-ordinates
FlowDepth Name of the file containing the depth values at the cell corners of
the grid
Aggregation Name of the aggregation file
Restriction:

¢ The maximum record length in the file is 132.

Example:

The model friesian_tidal_inlet contains three different subdomains (f01, f02, f03) and the
project file has the name <friesian_tidal_inlet.d3d.>

[FileInformation]
FileGeneratedBy

FileVersion
[DDBound]

= Deltares, Delft3D-DID0 Version 4.04.00.11836M, Jun 21 2010,
FileCreationDate = 2010-06-21,
= 0.03

13:35:22

FileDDBound = £34-123.ddb
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[Grid]
Type =
FileName =
Aggregation =
Monitoring Areas =
[Grid]
Type =
FileName =
Aggregation =
Monitoring Areas =
[Grid]
Type =
FileName =
Aggregation =
Monitoring Areas =

Aggregation file
File contents

RGF
£01.grd

£34_dd-£01.
£34_dd-£01.

RGF
£02.grd

£34_dd-£02.
£34_dd-£02.

RGF
£03.grd

£34_dd-£03.
£34_dd-£03.

dwq
dmo

dwq
dmo

dwq
dmo

The aggregation table of hydrodynamic volumes

Filetype ASCII
File format Free formatted
Filename <name.dwqg>
Generated D-Wag DIDO
Record description:
Record Record description
1 five integer numbers separated by a blank.
nmax number of computational volumes in n-direction
mmax number of computational volumes in &-direction
mmaxxnmax total number of computational volumes
XXX
XXX
2—-end one integer containing the aggregation volume index number
Restriction:

¢ The input items are separated by one or more blanks

Example:

Model area with 8 x 6 volumes (free formatted file).

LN e el ol el e Moo e )
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CTUUNMNOOUNUINNOODBDRERREOOBD

Remark:
¢ Number of records is equal to mmaz * nmax + 1

A.3 Land boundary file

File contents The co-ordinates of one or more polylines. Each polyline (piecewise
linear) is written in a single block of data.
Filetype ASCII
File format Free formatted
Filename <name.ldb>
Generated RGFGRID, QUICKIN, etc
Record description:
Record Record description

Preceding description records, starting with an asterisk (x), and will

be ignored.
1 A non blank character string, starting in column one
2 Two integers representing the numbers of rows and number of

columns for this block of data

Two reals representing the x, y or A, ¢-co-ordinate

Example:

*
* Polyline LOO7
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LO07

6 2
132400.0 549045.0
132345.0 549030.0
132165.0 549285.0
131940.0 549550.0
131820.0 549670.0
131585.0 549520.0

*

* Polyline LOO8

*

L008

4 2
131595.0 549685.0
131750.0 549865.0
131595.0 550025.0
131415.0 550175.0

*

* Polyline LOO9

*

L009

6 2
131595.0 549655.0
148975.0 564595.0
150000.0 564935.0
152105.0 565500.0
153150.0 566375.0
154565.0 567735.0

Remark:

¢ In case this file is read as a polygon file then the polylines are closed by D-Waq DIDO
to get a polygon.

Polygon file

File contents The co-ordinates of one or more polygons. Each polygon is written
in a single block of data

Filetype ASCII

File format Free formatted

Filename <name.pol>

Generated RGFGRID, QUICKIN, D-Waq DIDO, etc

Record description:

The file may contain one or more polygons. For every polygon the file should contain a line
indicating the name of the polygon, followed by a line indicating the number of points making
up the polygon and the number of coordinates, i.e. 2, finally followed by the coordinate data.
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Record Record description
Preceding description records, starting with an asterisk (x), and will
be ignored.

1 A non blank character string, starting in column one

2 Two integers representing the numbers of rows and number of
columns for this block of data
Two reals representing the x, y or A, ¢-coordinate

Restriction:

¢ The first record and the last record in the block should be the same

Example:

L I

Observation Area 001

5 2
1.8768018E+05
1.8996981E+05
1.9746314E+05
1.9480925E+05
1.8768018E+05

Observation Area 002

5 2
2.0011703E+05
1.9819166E+05
2.0568498E+05
2.0797461E+05
2.0011703E+05

Observation Area 003

54

5 2
1.9340425E+05
2.0183425E+05
1.9944054E+05
1.9522555E+05
1.9340425E+05

Deltares, Delft3D-DID0 Version 3.39.01.4423:4459, Sep 25 2008, 20:10:54
2008-09-25, 22:11:08

6.1708738E+05
6.1001035E+05
6.
6
6

1266423E+05

.1838830E+05
.1708738E+05

6.1818015E+05
6.1063479E+05
6.
6
6

0870942E+05

.1599460E+05
.1818015E+05

.1396516E+05
.1365294E+05
.05658720E+05
.0595146E+05
.1396516E+05
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A.5 Orthogonal curvilinear grid file

File contents The co-ordinates of the orthogonal curvilinear grid at the depth points.
Filetype ASCII
File format Free formatted
Filename <name.grd>
Generated RGFGRID
Record description:
Record Record description

Preceding description records, starting with an asterisk (x), will be

ignored.

1 Record with Co-ordinate System = Cartesian or value
Spherical

2 The number of grid points in m- and n-direction (2 integers).

3 Three real values (not used).

4 to K+3 A label and record number, the x-component of the world co-

ordinates of all points in m-direction, starting with row 1 to row nmazx,
with as many continuation records as required by mmax and the
number of co-ordinates per record. The label and record number are
suppressed on the continuation lines. This set of records is repeated
for each row until n = nmax.

K+4 to 2K+3 A similar set of records for the y-component of the world co-
ordinates.

K'is the number of records to specify for all grid points a set of x- or y-co-ordinates.

Restrictions:
¢ The grid must be orthogonal.
¢ Input items in a record are separated by one or more blanks.

Example:

*

* Deltares, Delft3D-RGFGRID Version 4.16.01.4531, Sep 30 2008, 23:32:27
* File creation date: 2008-10-01, 23:19:22

*

Coordinate System = Cartesian

9 7
000
Eta= 1 0.00000000000000000E+00  1.00000000000000000E+02  2.000000. ..
5.00000000000000000E+02  6.00000000000000000E+02  7.000000. ..
Eta= 2 0.00000000000000000E+00  1.00000000000000000E+02  2.000000. ..
5.00000000000000000E+02  6.00000000000000000E+02  7.000000. ..
Eta= 3  0.00000000000000000E+00  1.00000000000000000E+02  2.000000. ..
5.00000000000000000E+02  6.00000000000000000E+02  7.000000. ..
Eta= 4 0.00000000000000000E+00  1.00000000000000000E+02  2.000000. ..
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5
Eta= 5 0
5
Eta= 6 0
5
Eta= 7 0
5
Eta= 1 1
1
Eta= 2 2
2
Eta= 3 3
3
Eta= 4 4
4
Eta= 5 5
5
Eta= 6 6
6
Eta= 7 7
7

.00000000000000000E+02
.00000000000000000E+00
.00000000000000000E+02
.00000000000000000E+00
.00000000000000000E+02
.00000000000000000E+00
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02

A.6 Computational grid enclosure

NN OO AW WNNEFE,ERP,ORR, OO RO

.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02
.00000000000000000E+02

NN OO A WWNNRENDNNDNN N

.000000. ..
.000000. ..
.000000. ..
.000000. ..
.000000. ..
.000000. ..
.000000. ..
.000000. ..
.000000. ..
.000000. ..
.000000. ..
.000000. ..
.000000. ..
.000000. ..
.000000. ..
.000000. ..
.000000. ..
.000000. ..
.000000. ..
.000000. ..
.000000. ..

The computational grid enclosure file need to be specified, the file is generated by RGFGRID,
see RGFGRID (2013).

File contents

The indices of the external computational grid enclosure(s) and op-
tionally one or more internal computational grid enclosures that out-
lines the active computational points in a Delft3D-FLOW computa-
tion. The file is strongly related to the curvilinear grid file.

Filetype ASCII

File format Free formatted

Filename <name.enc>
Generated RGFGRID

Record description:

Record Record description

All One pair of M and N indices representing the grid co-ordinates

where a line segment of the computational grid enclosure (polygon)
changes direction.

® Restrictions:

¢ A polygon must be closed. The first point of the polygon is repeated as last point.

¢ A line segment may not intersect or touch any other line segment.

¢ The angle formed by consecutive line segments (measured counter clock-wise) can
have a value of: 45, 90, 135, 225, 270 or 315 degrees, but not 0, 180 and 360 degrees.

¢ In a row or column there should be at least two active computational grid cells.

¢ Input items in a record are separated by one or more blanks.

Example:
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IN- direction
8 + -;—- + - - - + -+ -+ -
7 + - + - + -+ -+ -+ -+ -+ -+ -+ -+ -+ -+ -+ -+ -+ -+ -
6 ;f- + -4+ -+ -+ - 4+ -+ - +-+ -4+ 4+-+ -+ -+ -+ -+ -+ -
5 ) ;—- + -+ -+ -+ -+ -+ -4+ - -+ -+ + -+ -+ -+ -
4 -+ + -+ -+ -+ -+ -+ -+ -+ -+ -+ -+ F+ - + - + - + -
3 - !—_ + -+ -+ - 4+ - + -+ - + - + -4+ - 4+ -+ - + -+ -+ -
2 I+ ;—- + -+ -+ -+ -+ - Ft+ -+ -+ -+ -+ -+ -+ -+ - + -
1 i { _ :F _i+ o " " " ’/: oo -+ -
1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19
_» M- direction
Legend
+ water level point
] v-velocity point
— u-velocity point
Full thick line grid enclosure and (for the external polygon only) loca-
tion of water level open boundaries.
Full thin line location for velocity or discharge open boundaries.

Figure A.1: Example of computational grid enclosures

Model area with (one) external and one internal polygon, see Figure A.1.

H
~
DO AR DR IOOND R R WWR R

Bathymetry file
File contents

Filetype
File format
Filename
Generated

Deltares

begin external polygon

end external polygon
begin internal polygon

end internal polygon

The bathymetry in the model area, represented by depth values (in
metres) for all grid points.

ASCII

Free formatted or unformatted

<name.dep>

FLOW-GUI (only for uniform depth values).

Offline with QUICKIN and data from digitised charts or GIS-database.
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Record description:
Filetype Record description
Free formatted Depth values per row, starting at N = 1 to N = Nmax, separated
by one or more blanks. The number of continuation lines is deter-
mined by the number of grid points per row (Mmax) and the maxi-
mum record size of 132.
Unformatted Mmax depth values per row for N = 1 to N = Nmax.

® Restrictions:
¢ The file contains one M and N line more than the grid dimension.
¢ The maximum record length in the free formatted file is 132.
¢ Depth values from the file will not be checked against their domain.
¢ The input items are separated by one or more blanks (free formatted file only).
¢ The default missing value is: —999.0

Example:

File containing 16 x 8 data values for a model area with 15 x 7 grid points (free formatted file).

1.0 2.0 3.0 4.0 -50 -5.0 -5.0 8.0 9.0 10.0 11.0

12.0 13.0 14.0 -5.0 -999.0
3.0 4.0 5.0 6.0 7.0 -6.0 -6.0 10.0 11.0 12.0 13.0
14.0 15.0 16.0 17.0 -999.0
5.0 6.0 7.0 80 9.0 10.0 -7.0 12.0 13.0 14.0 15.0
16.0 17.0 18.0 19.0 -999.0
7.0 8.0 9.0 10.0 11.0 12.0 13.0 14.0 15.0 16.0 17.0
18.0 19.0 -7.0 19.0 -999.0
9.0 10.0 11.0 12.0 13.0 14.0 15.0 16.0 17.0 18.0 19.0
20.0 19.0 18.0 17.0 -999.0
-7.0 12.0 13.0 14.0 15.0 16.0 17.0 18.0 19.0 20.0 19.0
18.0 17.0 16.0 15.0 -999.0
-8.0 -8.0 15.0 16.0 17.0 18.0 19.0 20.0 19.0 18.0 17.0
16.0 15.0 14.0 13.0 -999.0

-999.0 -999.0 -999.0 -999.0 -999.0 -999.0 -999.0 -999.0 -999.0 -999.0 -999.0

-999.0 -999.0 -999.0 -999.0 -999.0

A.8 Open boundaries file

File contents The location and description of open boundaries.

Filetype ASCII

File format Fix formatted for text variables; free formatted for real and integer

values.
Filename <name.bnd>
Generated FLOW-GUI

Record description:
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Record Record description

each record Name of the open boundary section (20 characters).
Type of boundary (1 character).

water level

current

Neumann

discharge per grid cell

total discharge for boundary section
Riemann

T 40 Z20N

Type of data (1 character).

A astronomic

H harmonic

Q QH tables (only for water level boundaries)
T time-series

Grid indices of the begin and end point of the boundary section (4
integers).

Reflection coefficient (1 real), not for Neumann or Riemann.

Vertical profile (three strings); only for 3D simulations and velocity
type boundaries (C, Q, T and R).

Uniform

Logarithmic

3D profile
Two labels (each 12 characters, no blanks in the label name) refer-
encing to the blocks in the amplitude and phase file <x.bca>; only if
the type of data is A.

Restrictions:
¢ Maximum record length in the free formatted file is 132.
The boundary section name must start at position one in a record.
The value of the reflection coefficient will not be checked on its domain.
All input items in a record must be separated by one or more blanks.
Astronomic and harmonic forced boundaries must be specified before QH-relation forced
boundaries, which in turn should be specified before time-series forced boundaries.
¢ Astronomic and harmonic forced boundaries cannot be combined.

<
<
<
<

Example:

Two boundary sections with data type A(stronomic) and one with type T(ime series).

Paradise Bay 1 QA 1 1 1 5 0.0 Uniform Paradise_1A Paradisee_1B
Paradise Bay 2 CA 16 3 16 6 0.0 Logarithmic Paradise_2A Paradisee_2B
Sea Entrance ZT 4 8 14 8 0.0

Remarks:
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¢ A label may not contain blanks between non-blank characters.
¢ For the labels 12 characters are read. Be sure the second label starts at least 13
positions after the start of the first.

Observation area information file

File contents
Filetype
File format

Filename
Generated

Record description:

Name of the polygon with observation areas.

ASCII

Fix formatted for text variables, free formatted for real and integer
values.

<name.oai>

D-Wagq DIDO, or manually offline

A header block containing information about versions, and the name of the polygon file.

For each observation area the details.

Keyword

Description

FileInformation

FileCreatedBy

D-Wagq DIDO version number

FileCreationDate

creation date and time

FileVersion version number of <x.aoi> file

General

Subject observation areas

PolygonFile name of polygon file with polylines defining observation areas

ObservationArea

Name

name of the observation area (blockname in polygon file)

Restriction:

¢ The maximum record length in the file is 132.

Example:

The number of observation areas is 3. They are called ‘ObsArea 001’, ‘ObsArea 002’ and

’ObsArea 003’.

[FileInformation]
FileGeneratedBy
FileCreationDate
FileVersion

[Generall
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Subject = Observation areas

PolygonFile = friesche_zeegat.pol
[ObservationAreal

Name = 0ObsArea 001
[ObservationAreal

Name = (ObsArea 002
[ObservationAreal

Name = ObsArea 003
Example polygon file:

* X ¥ ¥

WL | Delft Hydraulics, Delft3D-DIDO

22:57:01, 30-07-2008

ObsArea 001

5 2
1.8768018E+05
1.8996981E+05
1.9746314E+05
1.9480925E+05
1.8768018E+05

ObsArea 002

5 2
2.0011703E+05
1.9819166E+05
2.0568498E+05
2.0797461E+05
2.0011703E+05

ObsArea 003

5 2
1.9340425E+05
2.0183425E+05
1.9944054E+05
1.9522555E+05
1.9340425E+05

(23N> > Mo Me) [ 3N >N« > Mo Me)]

[ B> RNe N e)Ie))

Data monitoring file
File contents
Filetype

.1708738E+05
.1001035E+05
.1266423E+05
.1838830E+05
.1708738E+05

.1818015E+05
.1063479E+05
.0870942E+05
.1599460E+05
.1818015E+05

.1396516E+05
.1365294E+05
.0558720E+05
.05695146E+05
.1396516E+05

Volume numbers for each observation area.

ASCII

File format
Filename
Generated

Record description:

Free formatted.
<name.dmo>

D-Wagq DIDO, or manually offline

A header block containing information about versions, and the name of the polygon file.

For each observation area the details.

Deltares
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Record Record Description
1 Number of observation areas
2 Observation area name and number of segments belonging to this

observation area

NVOL integers indicating the volumes belonging to the observation
area

Restriction:
¢ The maximum record length in the file is 132.

Example:

The number of observation areas is 3. They are called ‘Observation Area 001’, ‘Observation
Area 002’ and 'Observation Area 003’

3

’Monitoring Area 001° 22
80 102 124 146 59
81 103 125 147 60
82 104 126 148 61
83 105 127 149 84
106 128

’Monitoring Area 002’ 37
275 297 210 232 254
276 298 189 211 233
255 277 299 212 234
256 278 300 213 235
257 279 301 214 236
258 280 302 215 237
259 281 303 260 282
304 283

’Monitoring Area 003’ 33
163 98 120 142 164
186 99 121 143 165
187 209 100 122 144
166 188 210 232 101
123 145 167 189 211
233 102 124 146 168
190 212 234
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DD Boundary file
File contents

Domain decomposition boundaries connecting two grids for the pre-
scribed indices.

Filetype ASCII
File format Fix formatted.
Filename <name.ddb>
Generated RGFGRID, or manually offline
Record description:
Record Record Description
N Name of the first grid, followed by four integers indicating the gridline

on which the boundary lies, followed by the name of the second grid
and four integers indicating the gridline on which the boundary lies.

Restrictions:

¢ No space allowed in grid filename.
¢ The maximum record length in the file is 132.

Example:

In the following example 4 sub-domains exist. Domain d01_ns is coupled to oal_ns, ob1_ns
and oc1_ns. Furthermore oa1_ns is coupled to ob1_ns, and ob1_ns to oc1_ns.

d01_ns.grd
d01_ns.grd
dO01_ns.grd
obl_ns.grd
obl_ns.grd

A.12 Dry points file

File contents

5 16 5 1 oal_ns.grd 28 356 28 20
245 1 5 1 obl_ns.grd 17 21 1 21
245 52 245 1 ocl_ns.grd 1 44 1 27

1 4 1 21 oal_ns.grd 28 3 28 20

17 4 17 21 ocl_ns.grd 1 10 1 27

Index location of (permanently) dry points.

Filetype ASCII
File format Free formatted
Filename <name.dry>
Generated QUICKIN or FLOW-GUI
Record description:

Record Record description

each record

The grid indices of the begin and end point of a dry section (4
integers).

Restrictions:

¢ The angle of a line of dry points and the horizontal numerical grid axis can be an integer
multiple of 45 degrees.
¢ Dry points may not be defined along the model boundaries (which by default lie along

Deltares
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n - direction
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Figure A.2: Dry points in model area

15

16

17,

18

the lines M =1, N =1, M = Mmax or N = Nmax). Therefore, the indices of these points

must lie between M = 2 and Mmax-1 and N = 2 and Nmax-1, respectively.

¢ The input items are separated by one or more blanks.
¢ The most lower-left dry point has indices (2, 2).

Example:

Five sets of dry points in a model area of 19 x 8 grid points, see Figure A.2.

5 3 5 6
8 4 10 6
13 3 14 3
13 4 14 4
14 6 14 6

Thin dams file
File contents

Location and type of thin dams.

Filetype ASCII
File format Free formatted
Filename <hame.thd>
Generated QUICKIN or FLOW-GUI
Record description:

Record Record description

each record

The grid indices of the begin and end point of a line of thin dams (4
integers). A character indicating the type of thin dams (U or V).

Restrictions:

¢ The angle of the line segment and the horizontal numerical grid axis may be an integer
multiple of 45 degrees.
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n - direction
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q m - direction

Figure A.3: Example of thin dams in a model area

¢ Thin dams can not be defined along the model boundaries (which by default lie along
the lines M = 1, N =1, M = Mmax or N = Nmax). Therefore, the indices of thin dams
must lie between M = 2 and Mmax-1 and N = 2 and Nmax-1 respectively.

¢ Input items are separated by one or more blanks.

¢ The direction of the dam is perpendicular to the velocity direction over which the dams
are superimposed!

Example:

Three (sets of) thin dams in model area of 19 x 8 grid points, see Figure A.3.

Colour scheme file
File contents
Filetype

File format
Filename
Generated

Record description:

Deltares

The colour scheme

ASCII

Free formatted

<name.clr> or <name.clrmap>
manually
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Record Record description

1 COLORMAP

2 NAME=name

3 SPACE=RGB, RGB is the only allowed space for this program
4—-N one real and three integers.

The first column represent the relative distribution of the defined colours in column 2—4 (rep-
resenting the RGB values).

Example:

COLORMAP
NAME=copper
SPACE=RGB

0.0000 0 O O
0.8000 255 159 101
1.0000 255 199 127

Settings file
File contents Settings of the program
Filetype ASCII
File format Fix formatted
Filename <name.ini>
Generated By the program
Record description:

Record Record description

FileInformation

FileCreatedBy

D-Wagq DIDO version number

FileCreationDate

creation date and time

FileVersion

version number of <x.ini> file

DIDOParameter

name integer value
Colours
name RGB value (3 integers)
line width
dots sizes
66 Deltares




Files of D-Waqg DIDO

Example:

[FileInformation]
FileGeneratedBy = Deltares, Delft3D-DIDO Version 4.04.00.11845:11904M, Jun 27 2010, 18:36:38

FileCreationDate = 2010-06-28, 09:30:32
FileVersion = 0.02
[DIDOParameter]
AutoscalelLegend = 1
XCoorLegend = 16
YCoorLegend = 20
StayOnStartupDirectory = 0
CellsToAggregate = 3
DeeperAggregation = 1.00000000000000002E+30
[Colours]
ColourBackground = 265 255 210

LegendColourBackground = 255 255 255
lineColourLandBoundary = 132 066 000

lineColourPolygon = 170 000 127
lineColourActiveGrid = 128 128 128
lineColourMarkVolume = 000 128 128

lineColourActiveVolume = 000 000 255
lineColourActiveCmpBnd = 005 005 005
lineColourActiveOpenBnd = 000 000 255
lineColourActiveDDBnd = 176 000 255
lineColourGrid = 192 192 192
lineColourVolume = 128 128 128
lineColourCmpBnd = 050 050 050
lineColourOpenBnd = 000 000 150
lineColourDDBnd = 176 000 255
pointColourVolumeCentre = 160 160 160
lineColourObsPolygon = 005 005 005
DryPoints = 000 000 000
ThinDams = 005 005 005
[Width]
lineWidthLandBoundary =
lineWidthPolygon =
lineWidthActiveGrid =
lineWidthMarkVolume =
lineWidthActiveVolume =
lineWidthActiveCmpBnd =
lineWidthActiveOpenBnd =
lineWidthActiveDDBnd =
lineWidthGrid =
lineWidthVolume =
lineWidthCmpBnd =
lineWidthOpenBnd =
lineWidthDDBnd =
pointSizeVolumeCentre =
lineWidthThinDams =
lineWidthObsPolygon =
[Caches]
inactdepth =
actdepth =
centre =

H WHE WO R R P OWER B WR

inactgrid =
actgrid =
inactvolumes =
actvolumes =
boundary =
landboundary =
obs_areas =

ONKF P, NWH OGO,

polygons =

Deltares 67



D-Waq DIDO, User Manual

drythdobs
rest
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